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Notices, Disclaimers and Terms of Use 
 

 
1. Limited Product Warranty. Homeland Security Technology Corporation (HSTC), warrants to the 
Client that the Products shall substantially conform to HSTC’s specification for a period of one (1) 
year from the date of the original purchase by the end user (the "Warranty Period").  As HSTC 's 
sole obligation and Client's exclusive remedy for any breach of warranty, HSTC agrees, at its sole 
option, to (i) use reasonable efforts to repair the Product with new or refurbished replacement parts; 
(ii) replace the Product with a new or refurbished unit; or (iii) refund the purchase price, provided 
Client returns the defective Products to HSTC with proof of purchase and HSTC’s authorization. 
 
HSTC’s warranty hereunder does not apply in case of any damage caused by accident, abuse, 
misuse, misapplication, or alteration of any kind performed by anyone other than HSTC.  The 
Products are not designed or licensed for use in mission-critical applications, or in hazardous 
environments, requiring fail-safe controls, including without limitation operation of nuclear facilities, 
aircraft navigation or communication systems, air traffic control, or life support or weapons systems.  
Without limiting the generality of the foregoing, HSTC specifically disclaims any express or implied 
warranty or condition of fitness for such purposes.  HSTC’s warranty does not, in any event, apply to 
physical damage to the surface of the Product or replacement.  HSTC shall have no obligation with 
respect to any data stored in the Product.  
 
Except as expressly stated in this section, HSTC makes no warranties or includes any conditions 
with respect to the products, express or implied, including, but not limited to, the implied warranties 
or conditions of merchantability, fitness for a particular purpose and no infringement. 
 
2. Liability Limitation.  In no event shall HSTC, be liable to Client, (and Client hereby waives any 
indirect, special, incidental, or consequential damages in connection with) the transactions 
contemplated by this agreement, whether or not such damages were foreseen, or their likelihood 
disclosed.  HSTC shall not be liable to Client or any third party claiming through Client, for any 
damages of any kind in excess of the amounts paid by Client under the terms of this agreement with 
respect to the products giving rise to such damages.  Some jurisdictions do not allow the exclusion 
of or limitation on implied conditions, warranties or damages, thus some of the foregoing may not 
apply to Client. 
 
3. Intellectual Property Rights.  Hardware and Software are proprietary to HSTC or its suppliers 
and are subject to copyright and other intellectual property laws.  Client's only rights with respect to 
any HSTC software included with the Products shall be provided, under the terms of HSTC ’s 
software license.  Title to all HSTC Software remains with HSTC.  Client agrees that HSTC retains 
ownership of all rights, title and interest in all intellectual property, works of authorship, trade secrets 
and like’s in all aspects of the Product(s).  Client and its affiliates and subcontractors agree not to 
reverse engineer any aspect of the Software and/or Products supplied under this agreement and 
further agree to pay assessed damages should such action take place. 
 
4. Copyright and Copies.  The Software (including any copy thereof) is owned by HSTC or its 
suppliers and is protected by United States, Canada, European, Brazilian and Australian copyright 
and patent laws and international treaty provisions.  The Software copy is licensed to you the client, 
not sold to you, and you (the client) are not an owner of any copy thereof.  You may make one copy 
of the software for backup or archival purposes.  You may not otherwise copy the software, except 
as authorized by applicable law, nor the written materials accompanying the Software.  HSTC 
hereby reserves all rights not explicitly granted in this license agreement. 
 
Copyright © 2005, HSTC. 

April 29, 2005 
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Note:  
Some smaller (sub-) municipalities may not contain street data. In such cases, please 
choose the larger (super-) municipality displayed in parentheses to search for these streets. 
Alternatively, you can change the search order to Street>City or ZIP/Postal Code>Street to 
find street data for the smaller municipality. 
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1 1 
Welcome To Destinator PN 

1.1 Introduction 
 
Destinator PN is a full-featured mobile satellite navigation 
system.  
 
It utilizes GPS (Global Positioning System) satellites to 
pinpoint your location utilizing the latest mapping data 
technology to get you to your destination in the most efficient 
and timely manner.   
 
Destinator PN assists you in planning your route and it 
provides Turn by Turn, Voice and Visual instructions for 
getting to your destination. 
 
 

1.2  Getting Help 
 
 

 

An abbreviated Help file with basic Destinator PN 
navigational definitions and instructions is available.   

At the map screen, press the  button, cycle to the 
Options Menu by pressing the  button, and 

select . 
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1.3 Technical Support   
 

 
In Europe 
 
For answers to common questions and quick assistance see the 
Destinator FAQ for Registered Users online at: 
http://www.destinatoreurope.com, click Community, login and 
choose FAQ.  
 
If you have other questions about Destinator PN, please contact 
your supplier or Destinator Technical Support via email at  
support@destinatoreurope.com  or telephone  
+49 (0) 1805 12 30 12 *. 

 
* for fees in your country please ask your telephone service provider 
 

 
 

In North America 
 
For answers to common questions and quick assistance see the 
Destinator FAQ for Registered Users online at: 
http://www.destinator1.com/, click Community, login and choose 
FAQ.  
 
If you have other questions about Destinator PN, please contact 
your supplier or Destinator Technical Support via email at 
support@destinator1.com  or telephone 1-866-798-0905 **. 
 

** toll free 
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2 2 
Installing Destinator PN 

2.1 Introduction 
This chapter will guide you through Destinator PN 
installation, map installation, and activation. 
 
There are four steps for installing Destinator PN: 
 
• Install Destinator Console on your PC 
• Install Destinator on your Pocket PC 
• Install the Map(s) on your Pocket PC 
• Activate Destinator on your Pocket PC 
 
 

2.2 Install Destinator Console  
 
Insert the Destinator PN Disk 1 into the PC’s CD-ROM 
drive, and the Destinator PN installer screen appears 
automatically. 
 

  
 
Figure 1 - Installation Language selection Pop-up 
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1. From the Select language pop-up– highlight your 

language preference and click OK. 
 
2. After reading the Welcome message click Next.    
 
3. We recommend that you use the default directory on 

your PC and click Next.   
 

Or, if you wish to install to a different installation 
directory click Browse and follow the onscreen 
instructions.   

 
4. Select the default Destinator language for your PDA.  

Click Next. 
 
5. An installation confirmation window is displayed.  Click 

Next. 
 
6. A status window indicates the progress of the 

installation.  
 

7. Click Finish to exit installer program. 
 
 

2.3 Install Destinator PN To Pocket PC 

Prerequisites 
 
Before you install Destinator PN, please confirm that: 
 
• Your Pocket PC has a minimum of 32 MB RAM and 

96 MB external memory 
• Your computer is running Microsoft Windows 

98/ME/NT/2000/XP with Microsoft ActiveSync 
• PC has ActiveSync loaded, running and Pocket PC is 

connected 
• PC has a minimum of 300 MB free for temporary files 
• You have an Internet connection for online 

registration 
 

  Note: The hardware and software requirements above are the minimum 
recommended to run Destinator PN. 
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Install Destinator 
 
Insert the Destinator Disk 1 into the PC’s CD-ROM drive. 
Launch the Destinator Console from the start menu on your 
PC.  
 
Start > Programs > DestinatorApps > Destinator Console 
 
 
 

1. Click the  button to install the Destinator 
Navigation System to your PDA.  

 
2. The End-User License Agreement (EULA) is 

displayed.  Please read it carefully and if you agree, 
click Yes, I Agree. 

 
3. A window gives you the option to install the TMC 

Traffic Message Channel) function, and allows you to 
choose a language.  See Section 6.13 TMC for more 
information about this feature. 

 

 
 
   Figure 2 - Install TMC Dialog 
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4. You are asked to which directory you would like to 
install.  Select Yes to install to the default directory, 
which is your Pocket PC’s main memory. 

 

 
 

                    Figure 3 - Install to Default Directory 
 
5. A status window indicates the progress of the 

installation. 
 

 
 

             Figure 4 - Status Window for Installation 
 
6. A window will refer you to your Pocket PC device 

screen for instructions. 
 

 
 

 Figure 5 - Refer to Device Screen 
 
7. After the software has been successfully installed, a 

“Program installation successful” message appears.  
Click No.  You will have an opportunity to register 
later. 
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Install TTS (Text To Speech) 
 
The TTS feature lets you hear street names as part of the 
voice prompts. 
 

1. Click on the  button on the toolbar 
at the top of your screen. 

 
2. Select your language preference for the voice 

prompts, and click OK. 
 

 
 
     Figure 6 - Select Language for TTS  

 
3. You are asked to which directory you would like to 

install TTS.  Select Yes to install to the default 
directory, which is your Pocket PC’s main memory. 

 

 
 
Figure 7 - Install TTS to Default Directory 
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4. A status window indicates the progress of the TTS 
installation. 

 

 
 
     Figure 8 - Status Window for TTS Installation 
 
5. You will be prompted when the installation is 

complete. 
 
 
 

2.4 Install The Map(s)  
 
This Section Covers: 
 
• Where to load maps 
• Selecting maps to load 
• Loading maps. 
 
 

Where to Load map(s)  
 

 
 

        Figure 9 - Change Target Device (Memory) 
 
1. From Target Device press Change to choose where 

to install maps. 
 

You can install the map(s) to the Pocket PC main 
memory, to a storage card plugged into the Pocket 
PC, or even an external Flash Reader with 
Removable Disk (fastest). 
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2. In the Select Target Device dialog, highlight where to 

install maps (eg: Storage Card) and click OK.   
 

The Target Device window displays the size of the 
map(s), and the available room on the storage card or 
main memory.   

 
 

Select Maps to Load 
 
1. Select the map(s) you wish to load by clicking on the 

map image or selecting them from the list. (√) 
represents a selected map to install. 

 

2. Press the  button.  
 
A Confirmation Dialog is displayed.  Press the OK 
button to install the map(s), or the Cancel button to 
exit map installation and return to select map(s).  A 
status window will indicate the progress of the map 
installation. 

 
 

3. When the map installation has completed, a 
Successfully loaded message appears.  Press OK. 

 
 
Before you can begin navigating, you must activate 
Destinator PN.  See the next chapter for instructions on how 
to activate Destinator PN. 
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3 3 
Activation 

3.1 Introduction 
After the map(s) have been installed, Destinator PN must be 
activated before you can begin navigating. 
 
 

3.2 Voucher For License Key 

 
If you received a Voucher to evaluate Destinator PN, note 
that it is not a License Key. 
 
You can easily redeem your voucher to get License and 
Activation Keys  (Activation Page), when you register at the 
Destinator Community at http://activate.destinator1.com. 
 
 

3.3 Quick Activation 

 
Destinator supports a feature called “Quick Activation”, which 
activates your Destinator product through an automated 
process that is faster than activating the product manually.  
 
For instructions on how to activate Destinator manually, 
please see Appendix B. 
 
If you have a PPCPE device, you might consider using SMS 
Activation, which is described in the next section. 

 
To activate your Destinator product with Quick Activation, do 
the following: 
 
1. Be sure your PC is connected to the Internet. 
 
2. Be sure your Pocket PC is communicating with your 

PC via Microsoft Active Sync. 
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3. Start the Destinator  program on your PC. 
 
4. From the toolbar at the top of the screen, select the 

 button. 
 

5. The Quick Activation screen appears.  Click Next to 
continue. 

 

 
   
 Figure 10 - Quick Activation Dialog 

 
6. The User Information screen is displayed.  Fill in the 

required information to create your account on 
Destinator Community, and click on Next. 
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Figure 11 - User Information Screen 

 
 
7. Enter the license key and select your device type.  

Click on Finish. 
 

         
          Figure 12 - License Key and Device Type 
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8. The message “Congratulations, your Destinator 
license key has been successfully activated” is 
displayed.  Click on Done to close the screen. 

 

 
 

Figure 13 - Quick Activation Completed 
 
 

3.4 SMS Activation 
Note: SMS Activation is available only if you have a PPCPE 
device.  If you do not have a PPCPE device, see Section 3.3 
Quick Activation for instructions about activation. 
 
If your Destinator PN is running on a PPCPE device, you 
can activate Destinator PN by using SMS Activation. 

 
1. As soon as your Destinator PN has been installed, the 

following screen will be displayed: 
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2. Key in your License Key number and press Next. The 
following screen is displayed: 

 

 
 

3. Be sure you read the text in the upper portion of the 
screen. Sending an SMS might mean that you will be 
charged by your carrier.  
 
If you want to continue with the SMS activation, click 
on Send. You will be prompted when your activation 
has been accepted. 
 
As an alternative to SMS activation, you might wish to 
use manual activation, which is described in Appendix 
B. To start manual activation, click on the Manual 
activation button. 
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4 4 
Hardware Installation 

4.1 Introduction 
 
This Chapter will guide you through the Destinator PN 
hardware installation procedure. 
 

 

Warnings 
Carefully select a safe location to install the Pocket PC device and 
GPS Antenna. 
 
DO NOT INSTALL the Pocket PC Device or GPS Antenna in any 
place that could: 
 

♦ Obstruct the driver's view of the road 
♦ Interfere with vehicle controls or safety devices 
♦ Cause injury to the driver or passengers 
♦ Interfere with the safe deployment of the airbags 

 
 
SECURE the Pocket PC device and GPS to the dashboard to 
prevent it from injuring driver or passengers in the event of a 
sudden vehicle movement or collision.  
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4.2 Connecting the Hardware 
  

  
 Installing Hardware. 
  1.       Pocket PC device.  
  2.       GPS antenna/receiver. 
  3.       COM connector. 
  4.      Cigarette Lighter Adapter. 

    
Figure 14 - Sample Hardware Installation 
 
If you are choosing a suitable location on the dashboard to 
install the Pocket PC device (1) mount, ensure that it does 
not obstruct the driver's view or interfere with other vehicle 
controls. 
 
If you are using a Destinator Bluetooth GPS Receiver, 
refer to your Bluetooth GPS Receiver User Guide. 

 
1. On your Pocket PC launch Destinator .  

(Some Pocket PC may lock up if the GPS is 
connected before launching Destinator). 

 
2. Connect the GPS (2) and cable (3) to the Pocket PC 

device. 
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3. Plug in the Cigarette Lighter Adapter (4) to power up 
the GPS Receiver and charge the Pocket PC.   

 
4. Check that the Cigarette Lighter adaptor power LED 

is ON.  
 

  Note: The GPS may take a few minutes to find its current location initially.  
For best results, ensure that the GPS has a clear view of the sky.   

 
 

 
 Disconnect the adaptor when the ignition is off.  This will help to 
 prevent unnecessary battery drain. 
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5 5 
Using Destinator PN Console 

5.1 Introduction 
 
This chapter will guide you through: 
 
• Toolbar Overview  
• Removing previous versions of Destinator 
• Loading more map(s) into memory  
• Selecting and loading pre-cut maps  
• Activating new maps 
• Setting up your preferences 
 
 
 

5.2 Menu and Toolbar Overview 

Toolbar 
 

 
Figure 15 - Destinator Console Toolbar 

 
• Install Software – Installs the latest version of Destinator 

software to your Pocket PC 

• Install / Remove Map – Dual function of installing new or 
self created maps or removing old not used maps to save 
memory 

• Cut Map – Allows you to create and cut own selection of 
map(s) 

• Favorites Importer – You can download a list of 
locations from your PC to your PDA to any category 
within Favorites. 
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• Text to Speech – This function inserts street names into 
the voice prompts at 200 meters prior to a turn, as well as 
when you reach the turn.  Once installed, the TTS feature 
must be enabled from the Alert Settings screen. 

• Quick Activation – Launches the process for activating 
your Destinator PN product using the Quick Activation 
method.  If you have a PPCPE device, you might 
consider activating your product by using the SMS 
Activation method described in Section 3.4 SMS 
Activation. 

 
 

File Menu 
 

 
 
• Install Software – Install the Destinator software. 

• Install Text to Speech – Install the Text to Speech 
feature, which includes street names into the voice 
prompts at certain manoeuvres. 

• Install Language – Install language preferences for use 
in voice prompts and skins.  After you install a language, 
you can implement it by going to the Settings menu and 
selecting Look & Feel (see Section 8.10 Look & Feel). 

• Install and Remove Maps – Install new or remove old 
maps. 

• Cut Map – Cut your selection from a large map. 

• Exit – Close down Destinator Console. 
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Tool Menu 
 

 
 

• Select Target Device – Select where to load map 

• Remove Maps – Remove old or unused maps to save 
on memory 

• Refresh map data – Load new map(s) and refresh 
installed map window 

• Favorites Importer – You can download a list of 
locations from your PC to your PDA to any category 
within Favorites. 

• Language – Select your Language to install Destinator in 
(default English) 

 
 

Help Menu 
 

 
 
• Tutorial – Brief interactive introduction on using 

Destinator 

• User Manual – Provides a detail description on using 
Destinator  

• Destinator Customer Support – Contact Destinator 
information 
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• Manual Registration on the Web – Destinator 
Community Registration web page 

• Quick Activation – To activate your Destinator product 
with Quick Activation 

• About Destinator Console – Version of Destinator 
Console 

 

Exit from Destinator Console 
 
1. When you are ready to exit the Destinator Console, 

click  
File > Exit.  

 

 
 
    Figure 16 - Quit Destinator Pop-up 
 
2. You will need to confirm that you want to Exit.  Press 

Yes and you will exit from the Destinator Console. 
 
 

5.3 Removal of Previous Destinator Versions 
 

1. The Destinator Console automatically checks if 
there is a previous version installed and will prompt 
you to remove it, before installing the latest version of 
Destinator. 

 

 
 

Figure 17 - Removal of Previous Installed Destinator Pop-up 
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2. Press the Yes button to completely uninstall the 
previous version and re-install the new version.  If you 
press No, Destinator will not install and you are 
returned to the Destinator Console main screen. 

 
 
3. Press the Yes button to continue to install the latest 

version of Destinator. 
 

Destinator Console will display a status window to let 
you monitor the installation’s progress. 

 
After the software has been successfully installed, a 
Program Installation successful message appears.   

 
4. Click No, you will have an opportunity to register later 
 

Now that you have installed the navigation software, 
you are ready to install the maps.  See Section 2.4 
Install The Map(s). 

 
 

 
You cannot install the Destinator navigation software to an 
external Flash Reader.   
 
 
 

5.4 Creating Your Own Maps 
 
Living in California, but need only the map and driving 
directions for San Francisco?  Well Destinator has made 
that easy with its simple to use Cut Map tool. 
 
 
1. From Standard Maps window select the map(s) you 

wish to load by clicking on the map image or selecting 
them from the list.  (√) represents a selected map to 
install. 
 

 

2. Press the Cut Map  button.  
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A Confirmation Dialog is displayed, press the OK 
button to install the map(s), or the Cancel button to 
exit map installation and return to select map(s).  The 
selected map is temporally loaded to hard disk.   

 
 
3. The map is displayed on screen - Then Zoom In 

 on a section, zone, selected area or city of 
interest. 

 

 
Some maps are already Pre-Cut.  See Selecting Pre-Cut 
Maps chapter 6. 
 
4. Use the toolbar for Address or POI selection, to 

Zoom, to select a sub-region, or Crop (to select a 
rectangular area to be cut). 

5. Click Crop  (Draws a Rectangle around area to 
cut – your selection eg: San Francisco)  

 

 
 
       Figure 18 - Crop Map Selection  (Rectangle) Window 
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5.5 Cutting Maps 

1. Click Cut Map  to create that selected zone 
(map). 

 

 
 

          Figure 19 - Entering a New Map name Pop-up 
 
2. Enter an unique name as the new map name eg: 

San_Frisco1. 

  Note: No spaces between words are allowed, but you can use 
underscores to separate the words (16 character maximum). 

 
3. Pressing Estimate gives the size of the selected map.  

Do you have enough memory available? Click OK. 
 
4. Click Cut – To automatically store the newly cut map 

on your computer.  
 

Destinator creates a default directory on your 
computer, C:\DestinatorApps\New Maps, where all 
cut maps are stored.  

 
5. Click OK.  From Destinator Maps Cutter, click File > 

Return to Console.  (You are returned to the 
Destinator Console). 
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5.6 Route Cutting 
Destinator supports route cutting, which allows you to create 
a map composed of a travel route.  To create the route, you 
specify two or more points. After the route has been created 
you can create a map from it and download the map to your 
Pocket PC. 
 
1. From the console, select one of the standard maps. 

The route you create will be restricted to the area of 
the predefined map. 

2. Click on Cut Map . An enlarged image of the 
map is displayed in the left-hand pane. 

3. Click on Route . Notice the additional window 
that is displayed in the right-hand pane. 

4. To establish a point on your route, click on the desired 
position on the map. A description of the point is 
displayed in the right-hand pane. To more precisely 
select a point,  you can click on Address or POI as 
the next section describes. The first point you define 
is considered the starting point of the route. A route 
must include at least two points. 

5. Some tools you can use when creating a route: 
Corridor - You can select how much surrounding 
area will be included along the route’s path. You can 
also choose either kilometers or miles. 
Route - You can select either the quickest or the 
shortest route to connect the points.  

 - Centers a point on the map. First, highlight 
the point in the right-hand pane, and then click the 
icon. 

 - Deletes a single point from the route.  First, 
highlight the point in the right-hand pane, and then 
click the icon. 
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 - Click on this icon to delete all points from the 
route.  

 and  - Changes the numerical order of 
the points on the map and in the right-hand pane. 
First, highlight a point in the right-hand pane, and then 
click one of these icons.  
 

6. When you have established all the points on the 

route, click the Create Route  icon. Notice that 
all the points become connected by a blue line that is 
bordered by a corridor. You  can use any of the tools 
described in step 5 to modify the route shown. If you 
modify the route, you will have to recreate the route 
by simply clicking on the Create Route icon again. 

7. To create a map of the route, click on Cut Map 

. You will be prompted to give the map a 
name. The map will be displayed in the “My Maps” 
section on the Destinator Console. Then, you can 
download the map to your Pocket PC just as you 
would download any other map as described in 
Chapter 2. 

 

 

5.7 Selecting Pre-Cut Maps 

Selecting by Address 
 
1. Select map to load from Standard Maps, eg:  Italy.  
 

2. Click Cut Map .  The selected map (Italy) is 
automatically loaded to hard disk and displayed in the 
Map Cutter window. 
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       Figure 20 - Pre-Cut Selection Window 
 

Do you have a specific Address, POI or Region that 
you need to map?  On the In Destinator Cutter, on the 
Toolbar select Address POI, zoom or sub-region to 
Cut. 

 

3. If you have a address choose the Address  
button, select by: City > Street and Home or City > 
Intersection. 

   
4. Eg: City - Milano then Street and Home - 

Giustiniano, Viale then click Show Address.  
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 Figure 21 - Select Address Sub Region Window 
 
 
5. In the Destinator Map Cutter main view the map is 

updated and selected area to be cut is centered and 
marked. 

 

6. From Toolbar, click Crop , select on the map 
where to draw rectangular zone to be cut.  (Move your 
curser to the area marked and draw a box around the 
previously marked area). 

 

7. Click Cut Map  to cut the selected zone.   
 

Selecting Map by Intersection 
 
If you need to select a map by Intersection: 
 
1. From Toolbar click Address, then click City > 

Intersection. 
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2. First, click City then the 1st Street and then 
Intersection. 

 
3. From the list, click 2nd Street. 
 
4. The map view is updated and area to be cut is 

centered. 
 

5. From Toolbar > Crop , then on the map select 
where to draw rectangular zone to be cut. 

 

6. Click Cut Map  to cut the selected zone.  See 
Cut Maps in Chapter 5. 

 
 

Selecting Map by Points of Interest (POI) 
 

1. From the Toolbar click . 
 
2. Select the POI eg: Golf Courses. 
 
 
3. Select your Golf Course.  (Ensure that it is 

highlighted). 
 

4. From Toolbar > Crop .  - On the map select, 
with the mouse, where to draw Rectangular zone to 
be cut. 

 

5. Click Cut Map  to cut selected zone.   
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Selecting by Sub Region 
 
(If you are ready using the Destinator Map cutter see step 3). 
 
1. On the Destinator Console select the main map to 

load from, eg: Italy.  
 

2. Click Cut Map  .  The Destinator Map Cutter 
is displayed. 

 
3. A list of sub-regions is, displayed on the right hand of 

the selected map.  Click on the sub-region to 
download. 

 

4. Click Cut Map  to cut selected zone.   
 
 

5.8 Loading Newly Created Maps to Pocket PC 
 
1. On the Destinator Console, to refresh Standard Map 

dialog, Click Tools > Refresh New Map Data.  
 
2. Select the map(s) you wish to load by clicking on the 

map image or selecting them from the list.  (√) 
represents a selected map to install. 

 
3. In Target device, click Change to select where to 

install the map(s).  You can install to Main Memory, 
Storage Card or Removable Disk (External Reader). 

 
You are, prompted to select the target device where 
maps are to be uploaded. 

 
 
4. Choose one (highlight) eg: Storage Card, click OK.   
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Confirm that there is enough memory to install map. 
 

5. Click .  A pop-up message requiring 
confirmation appears. 

 
 
6. Press OK to load map.  
 

Destinator Console will display a progress window to 
let you monitor the installation’s progress. 

 
7. When the map installation has completed, a 

Successfully loaded message appears.  Press OK. 
 
 
 

5.9 Removing Map(s) from Memory  
 

 
If you do not have Destinator Console launched:  
 
1. Insert the Destinator Disk 1, into the CD-ROM in your 

desktop computer, this automatically launches the 
Destinator Console.  

 

 
 
Figure 22 - Change Target Device  (Memory) 
 
2. In Target device click Change, select from where 

(which memory) to remove map(s).  This will update 
the Installed Map Window. 

 
3. The Installed Map Window displays a list of all the 

loaded maps available.  Click in the check box (√) 
beside the map(s) you wish to remove.   
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4. Press the  button to remove the 
selected map. 

 
5. Destinator requires that you confirm that you wish to 

remove the selected map(s).   
 
6. Press Yes, the selected map(s) are removed from 

memory. 
 
 

5.10 Activating New Maps  
 

If you have purchased extra maps or upgrades, you may 
need an addition(al) activation key(s) before you can use 
them.  
 
For example if you switch maps to an unregistered map, you 
will be prompted to register the map with the following Pop-
up message. 
 

 
 
Figure 23 - Map Not Registered Pop-up 
 
 
 

   Note: You cannot use unregistered maps on Destinator. 
 
1. Click YES.  The Destinator Activation Page is 

displayed.   
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   Figure 24 - Destinator Activation and Congratulations Dialogs 
 
2. Click +New to add a new license.  The 

Congratulations Page is displayed.  Do not enter 
anything on this screen yet.  Leave it as is. 

 
See  Online Activation in Chapter 3. 
 
 
 

5.11 Removing Navigation Software   
  

Remove the Destinator navigation software using the 
following method: 
 
1. Insert the Destinator Disk 1 into the CD-ROM drive in 

your desktop computer to launch the Destinator 
Console. 

 
2. Click File > Remove Software.  You will need to 

confirm that you wish to remove Destinator and 
Maps.  Press OK. 

 
This will remove the complete Destinator 
navigational system installation - software and maps 
from your Pocket PC device. 
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5.12 Exit From Destinator Console 
 

1. If you need to exit the Destinator Console File > Exit. 
 

You will need to confirm that you want to Exit the 
Destinator Console.  

 
2. Press Yes and you will exit. 
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6 6 
Navigating a Route 

6.1 Introduction 
This chapter will help you to define and plan a route.  You 
will be able to select a destination, set your origin, or plan a 
journey.  The route calculated in real time is from your 
current GPS position. 
 
There are several ways to determine your destination using 

the Menu button ( ).  You can navigate to: 
 
  
• An Address 
• An Intersection 
• A ZIP/Postal Code 
• A POI (Point Of Interest) 
• An Address in Favorites 
• An Address In History 
• A Contact 
• An SMS Inbox Item 



Destinator PN User Guide 

Page 48 of 118 

6.2 Map Description 
There are various buttons and icons on the map screen that are 
used to plan and view a route.  

 

                                            

Compass Button 

Driving Directions Button 

 View Selector Button 

GPS Status  
Button Route Details Button 

GPS - Generated  
Statistics Button 

Menu Button 
Current Location 

Battery Status  
Indicator 

Home Button 

Exit Button 

Zoom Scroll Bar 

Length Scale Indicator  
        
   Figure 25 - Main Map View 

 
 
Location Icons 
 

  (or  in Pedestrian Mode) shows your current location 
while in Navigation Mode. 
 

  (or  in Pedestrian Mode) shows your last known GPS 
location while in Navigation Mode.  This is not your current 
location, because there is no valid GPS information at this time. 
 

 (or  in Pedestrian Mode) shows the Origin in Planner 
Mode. 
 
 
See Section 8.7 Route Settings for descriptions of Navigation 
Mode and Planner Mode. 
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Dynamic cursor 
Destinator PN's screen cursor has the capability to automatically 
change its appearance so that you will be informed of several 
important navigation conditions: 
 
• The cursor indicates if you are in Car or Pedestrian mode 

• The cursor indicates if you are driving at high or low speeds. 
The cursor becomes elongated at higher speeds and wider at 
lower speeds. 

• The cursor displays a shadow that shows the position of the 
Sun. This is especially important if you are using Destinator 
PN in Pedestrian mode. By positioning yourself so that the 
shadow that you cast is in the same position as the shadow on 
the screen, you can be assured that you are walking in the 
right direction. 

• The cursow shadow disappears during night driving. 
 
 
Map Screen Buttons 
 

 Toggles between Turn by Turn details and a complete list of 
Driving Directions. 
 

 Toggles between 2D, 2D Night, 3D and 3D Night views.  The 
icon indicates the next view to be displayed. 
 

 Shows magnetic direction as you move. 
 

 Lets you define and plan your route via the Destination 
Menu.  Also allows you to access the Options Menu and Settings 

Menu.  Indicates whether you are in Vehicle Mode ( ) or 

Pedestrian Mode ( ).  You can change modes by holding 
down the button for several seconds, or by opening the Options 

Menu and pressing either  or .  In Pedestrian Mode, 
the navigation radius is restricted to 10 kilometres (6 miles). 
 

 Displays details about your route, such as ETA, ETR and the 
distance to your destination. 
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 Displays GPS–generated information, such as UTM 
(Universal Transverse Mercator), geographic position, current 
location, altitude, and speed.  The icon indicates the next item to 
be displayed. 
 

 Displays GPS status, such as information about your satellite 
fix, and the latitude, longitude and altitude of your position.  The 
icon appears green when there is a GPS fix, and red when there 
is no GPS fix.  Also provides a link to the GPS Settings screen. 
 

 Displays battery status.  When the battery power is low, a 
message box will appear. 
 

 Calculates a route to a pre-set POI or address. 
 

  Lets you exit from the Destinator PN application. 
 
Menu Button   

This button is shared by two functions: Vehicle Mode ( ) and 

Pedestrian Mode ( ).  You can toggle between these two 
modes by holding down this button for several seconds.  In 
Pedestrian Mode, the navigation radius is restricted to 10 
kilometres (6 miles). 
Press the Plan Button to open the Destination Menu.  Pressing 

the  and  buttons at the bottom of the 
screen allows you to cycle between the Destination Menu, the 
Options Menu and the Settings Menu as seen in Figure 26. 
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        Figure 26 - Menu Structure 

 
 
 

Landscape View   
Destinator PN supports full landscape operation that is compatible 
with Windows Mobile SE devices. This view is particularly useful 
for navigation when you want to see more of your lateral 
surroundings. Destinator PN adjusts the screen view to fit either 
portrait or landscape mode. 
 
 

6.3 The Destination Menu 

1. At the map screen, press the  button to open the 
Destination menu. 

 

 
 
2. You can choose your destination from the following 

options: 
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• Address list 
• Point of Interest (POI) list 
• Favorites list 
• History list 
• Contact list 
• SMS Inbox 

 
3. From your current position, the route is calculated and 

displayed as a blue line. The green triangle  
represents your Origin (or departure point).   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

    
  

 
   Origin 
 
   

 
 

  
Route 
 
 

   Figure 27 - Main Map View Dialog 
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6.4 Navigate To An Address (or Intersection)  
 

 
 
When you navigate to an address, there are several ways of 
defining your destination.  You can navigate to a destination 
by selecting an address, a ZIP/Postal Code, or an 
intersection.   
 
The Cross Region Navigation feature lets you navigate a 
route that extends across more than one region on the same 
continent, without having to switch maps.  This feature 
becomes available only when you have the following maps 
installed:  the map of your origin, the map of your 
destination, and a map of the major roads for that continent 
(e.g. major roads of Europe).  When the Cross  Region 
feature is enabled, you can press Region to display a list of 
installed maps, and select the map pertaining to your 
destination.  Destinator PN will automatically change maps 
as you travel across regions, displaying your route at the 
same level of detail as you drive.  You will not need to switch 
maps during your route. 
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Figure 28 - Address Screen with Region Feature 
 
 
 
The default order for entering your destination is City -> 

Street -> Number, but by clicking on the  button, you can 
cycle through the different ways of specifying your address. 
 
 

                                   
                                    

Click on this 

  
button to change 
 your search type. 

 
  Figure 29 - Address Search Screen 

 
 
 
 

 Lets you search for an address by first entering the 
City, then the Street, then the Number. 

 

 Lets you search for an address by first entering the 
Street, then the City, then the Number. 

 

 Lets you search for an address by first entering the 
ZIP/Postal code, then the Street, then the Number. 

 

 Lets you search for an address by first entering the 
Street, then the ZIP/Postal code, then the Number. 
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 Lets you search for an intersection by entering the 
City, the first Street, then the intersecting Street. 
 

 
For example, to navigate to an address using the City -> 
Street -> Number search order: 
 
1. Press Region if you are navigating a route across 

several maps.  Highlight your selection from the list of 
installed maps.  (If only one map is installed, you will 
not see the Region option.) 

 
2. Press City and use the keyboard to enter the first few 

characters of the city name.  The scroll list will update 

accordingly. Press the  button to expand the list 
for easier scrolling.  You can also change your 
keyboard from uppercase to lowercase by pressing 

the  button. 
 
3. Press Street to display a list of street names for the 

selected city.  Select the street name by entering the 
first few characters or by scrolling down the list (eg: 
Birch, Ave).  

 
4. Not all cities/towns are mapped to the street level.  In 

such cases, the software will display Street data not 
found.  You can still navigate to the city as selected. 

 
5. Press Number and enter the number using the 

keyboard.   
 

6. Once you have entered your destination, there are 
several options available on the toolbar found at the 
bottom of the screen. 

 
 

 Calculates and displays your route, which 
is shown as a blue line on the map. 

 Shows the destination on the map and 
displays its details. 
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 Allows you to add the destination to your 
Favorites Folder, or to set it as your Origin. 
If you are using a PPCPE device, you can also send 
(as an SMS message) the location to someone in 
your Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted address. See Appendix C for more 
information about sending locations. 

 
 

As you drive, Destinator PN provides you with turn-by-turn 
voice and visual directions, letting you know when your next 
turn is coming up until you arrive at your destination. 
 
 
 

 

If you don’t know the entire name of a city or street, type in part of the 

name and press the  button. This will display a list of all names 
containing your typed sequence. 

 

For more information on a City, Street or Number click  to display 
details about the location, such as its city, street name, and latitude and 
longitude coordinates. 
 

 
 

 
Note:  
Some smaller (sub-) municipalities may not contain street data. In such cases, 
please choose the larger (super-) municipality displayed in parentheses to search for 
these streets. Alternatively, you can change the search order to Street>City or 
ZIP/Postal Code>Street to find street data for the smaller municipality. 
 
 
 

6.5  Navigate To A Point of Interest (POI) 
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The Points of Interest (POI) list is a collection of potential 
destinations of interest in predefined categories.  POIs are 
identified on the map by various icons (eg:  Restaurants).  
POI navigation is especially handy when you need to find a 
facility, attraction or amenity by category or type.  For 
example, you can ask Destinator PN to guide you to the 
closest bank, mall, hotel, restaurant, gas station, etc. 
 
The Cross Region Navigation feature lets you navigate a 
route that extends across more than one region on the same 
continent, without having to switch maps.  This feature 
becomes available only when you have the following maps 
installed:  the map of your origin, the map of your 
destination, and a map of the major roads for that continent 
(e.g. major roads of Europe).  When the Cross  Region 
feature is enabled, you can press Region to display a list of 
installed maps, and select the map pertaining to your 
destination.  Destinator PN will automatically change maps 
as you travel across regions, displaying your route at the 
same level of detail as you drive.  You will not need to switch 
maps during your route. 
 
1. From the Destination Menu, press the POI button. 
 
2. Press Region if you are navigating a route across 

several maps.  Highlight your selection from the list of 
installed maps.  (If only one map is installed, you will 
not see the Region option.) 

 

 
          Figure 30 - POI Regions 

 
3. Press Category and highlight your selection from the 

list of POI categories.  For example, we can search 
for the nearest restaurant.   
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Figure 31 - POI Categories  

 
 
 
 

 

 

 

At this point, you can display all the items within a category on the 
map screen by tapping the  button beside any of the 
categories.  When selected, the button will appear as .  Press 

 to return to the map screen. 
 
 

 
 

4. With Restaurants highlighted, tap Items to display a 

list of Restaurants in your area.  Press the  
button to expand the list  The POIs are listed in order 
of distance.  To sort them alphabetically, press the 

 button. 

5. Highlight your choice and click  to calculate 
your route.  The route is shown on the map as a blue 
line from your current GPS position. 

6. You can select  to preview your destination 

on the map, or press  to add the destination 
to your Favorites or to set it as your Origin. Select 
Settings to define your Search Radius and Search 
Center.  
 If you are using a PPCPE device, you can also send 
(as an SMS message) the location to someone in 
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your Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted POI. See Appendix C for more information 
about sending locations. 

    
As you drive, Destinator PN provides you with turn-by-turn 
voice and visual directions, letting you know when your next 
turn is due. 
 
 

6.6 Navigate To A Favorite 
 

 
 
You can select a destination from your list of stored 
Favorites.  (The next section describes how to save an item 
to your Favorites list.) 
 
A Favorite is an address or destination previously stored by 
you for quick and easy retrieval.  You can also save, edit or 
delete destinations from this folder. 
 
1. From the Destination menu, press the Favorites 

button.  Your list of Favorites categories is displayed. 
 
2. Highlight My Favorites and tap Items.  A list of stored 

items is displayed.   
 

3. Highlight your selection and click  to 
calculate your route.  The route is shown on the map 
as a blue line from your current GPS position. 

 

4. You can also select  to preview your 

destination on the map, or press  to edit or 
delete your choice, or to set it as your Origin.  
 
 If you are using a PPCPE device, you can also send 
(as an SMS message) the location to someone in 
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your Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted Favorite. See Appendix C for more 
information about sending locations. 

 
As you drive, Destinator PN provides you with turn-by-turn 
voice and visual directions, letting you know when your next 
turn is due. 
 

6.7 Save To Favorites   
When selecting a Destination which you may use regularly, 
you can save it to your personalized Favorites list.   
 

1. At the map screen, press the  button to open the 
Destination menu. 

 
2. Select and specify your desired destination as 

described previously, be it from Address, POI, 
History or Contacts. 

 
3. To save the location in your Favorites folder, click the 

 button and select Favorites.  The Edit Item 
Properties screen is displayed. 

 

 
 

Figure 32 - Adding An Item to Favorites 
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4. Enter a name and comment that will help you 
recognize the item in future. 

 
5. Enter a new category name (eg: Must see) or select 

an existing one and press Save. 
 
Your favorite destination has now been stored for future use. 
 
 
 
 

6.8  Navigate To A History Item 
  

 
 
History allows you to select an existing destination from a 
list of previously traveled routes.  The software automatically 
stores the last few destinations in memory.  As each new 
route is added to the top of the list, the older destinations at 
the bottom are erased.   
 

 
 

Figure 33 - History List 
 
1. From the Destination Menu, press the History button 

to display your list of previously traveled routes. 
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2. Highlight your selected History item and click 

 to calculate your route.  The route is 
shown on the map as a blue line from your current 
GPS position. 

 

3. You can also select  to preview your 

destination on the map, or press  to add the 
destination to your Favorites or to set it as your 
Origin. 
 
 If you are using a PPCPE device, you can also send 
(as an SMS message) the location to someone in 
your Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted History item. See Appendix C for more 
information about sending locations. 

 
 
 
 
 
 
 
 

6.9 Navigate To A Contact 

 
 
Your PDA includes a Contacts folder, which can be found 
under the Start menu.  The Contacts folder contains a list of 
contact information for people and places.  Destinator PN 
lets you use the address specified in a contact as a 
navigation destination. 
 
1. From the Destination Menu, press the Contacts 

button to display your list of contacts.   
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           Figure 34 - Contacts List 
 
2. Highlight the contact you want to navigate to, and 

press Info to display detailed information for your 
contact.  Confirm that this is the address you want to 
navigate to. 

 

 
        
      Figure 35 - Contact Info Screen 

 
3. Press Address and a list of addresses that closely match 

the one defined in the contact is displayed.  If no address 
information exists for that contact, a message box will 
appear. 
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Figure 36 - List of Possible Addresses 

 

4. Highlight your selection and click  to calculate 
your route.  The route is shown on the map as a blue line 
from your current GPS position. 

 

5. You can also select  to preview your destination 

on the map, or press  to edit your choice, add 
it to your Favorites, or set it as your Origin. 
 
 If you are using a PPCPE device, you can also send (as 
an SMS message)  the location to someone in your 
Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted Contact. See Appendix C for more 
information about sending locations. 

6.10 Navigate To An SMS Inbox Item 
 

Destinator PN allows you to receive a location from 
someone via an SMS message.  This feature is available 
only if you have a PPCPE device.  In order to send you a 
location, the sender must also have a PPCPE device that is 
running Destinator PN, or a Destinator SP (SmartPhone).  
The SMS message will include a location to which you can 
navigate. 
 
When you are at the main map screen, you will be notified 
by an Alert Icon  when an SMS message is received.  To 
navigate to the location sent to you via an SMS message: 

 
1. Tap on the Alert Icon to open the SMS Inbox.  A list of 

received SMS messages is displayed. 
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2. The item at the top of the list is the most recent SMS 
message.  When you highlight this item, information 
about the location is displayed at the bottom of the 
screen. 

3. With the SMS message highlighted, click  
to calculate your route.  The route is shown on the 
map as a blue line from your current GPS position. 

4. You can select  to preview your destination 

on the map, or press  to add the destination 
to your Favorites or to set it as your Origin.  
 
If you are using a PPCPE device, you can also send 
(as an SMS message) the location to someone in 
your Contacts list. Click on Send Location. The SMS 
message will automatically include the location of the 
highlighted item. See Appendix C for more 
information about sending locations. 

 
You can also access your SMS Inbox from the Destination 
Menu.  The SMS Inbox button will be enabled only if you 
have a PPCPE device.  
 
 

6.11 Navigate To A Point on the Map 
You can navigate to any point on the map by tapping its 
location directly on the map screen. This feature is especially 
handy when you want to navigate to a specific point you see 
on the map, but you don’t have its street address.  
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       Figure 37 - Map Cursor Dialog 
 
1. Use the stylus to scroll or drag the map to a specific 

point, and then tap the desired location.   
 
2. A dialog box displays the address of that point, and 

lets you select whether you want to navigate to it, 
recalculate your route, add the point to your Favorites, 
or set it as your Origin (if you are in Planner Mode).  

 
3. To clear the cursor dialog, just tap the screen again. 

 
4.  If you are using a PPCPE device, you can also send 

(as an SMS message) the location of any point on the 
map to someone in your Contacts list. The SMS 
message will automatically include the location of the 
highlighted History item.  
 
Tap on any point on the map and click on Send 
Location. See Appendix C for more information about 
sending locations. 

  

 

If you need to reset the point of Origin, tap the map screen 
to open the Cursor Dialog, and select Set As Origin.  All 
new route calculations will use this as the starting point, but 
only if you are in Planner Mode.  In Navigation Mode, your 
current GPS location is always your Origin. 

Dialog Box on the 
Map Screen  



Destinator PN User Guide 

Page 67 of 118 

 

6.12 Trip Planning 

 
 
Trip planning is useful when you have more than one 
destination along your route.  This process is similar to the 
procedures used to enter or select a destination and initiate 
navigation, except that you must be in Planner Mode.  

   When you press , the Route is calculated in stages, from 
the departure point to the first waypoint.  Once you’ve reached the first 
waypoint, the route is recalculated to the second waypoint, and then 
recalculated to the third waypoint, and so on. 

 

How to Use Trip Planning 
 
Use the following method to plan a trip: 
 
1. Ensure you are in Planner Mode.  To do this, press 

the  button and cycle to the Settings Menu. 

2. Press Route Settings    and for Routing mode, 
select Planner mode.   

 

 
 

3. Press the  button to save and return to the map 
screen. 
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4. At the map screen,  press the  button and select 

Trip Planner  from the Destination menu.   

   Note: If this is the first time you are using Trip Planner you will need 
to create a Trip Folder in which to store your trip details.  You can use any 
name.  For this example we will be using My trip. 

 
5. From the tool bar at the top of the screen, click Tools 

and select Add to create a trip folder. 
 

 
 

    Figure 38 - Adding a Trip Folder 
 
6. Enter the name of your trip folder (e.g. My trip) and 

press Save.  You can now enter the waypoints of your 
trip. 

 
What is a waypoint?  A waypoint is a stop or break in your journey, along 
a predefined route. 

 
7. Highlight your trip folder, and press Waypoints above 

to define your waypoints. 
 
8. From the tool bar at the bottom, click Tools and 

select Add to define your waypoints.  
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9. Select the address of your first waypoint – be it an 
Address, POI, Favorites or History – and press 

. 
 

10. In the Edit WayPoint Properties screen, you can 
change the name or details of the waypoint.  Press 
Save to add to your trip. 

 
Repeat steps 6 to 9 to enter all the waypoints. 
 

 
 
Figure 39 - Trip Planner and Waypoints Dialogs 
 

11. Select the Show  button to view the complete 
route.  The first part of the route is shown as double 
blue lines. The remaining parts of the route are shown 
in a series of single line vectors. 

 
12. Using  or  , you can 

change the order of your waypoints to suit your 
purposes. 

 
13. You can also click on Tools > Optimize, which will 

automatically sort the waypoints for the most effective 
and quickest route. 

 

14. To calculate the route, press Navigate .  
The route is shown as a blue line from your current 
GPS position. 
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* Remember to change back to Navigational Mode. * 

See Section 8.7 Route Settings for a description of Navigation 
Mode and Planner Mode. 
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6.13 Avoid Roads 

 
You can specify that certain roads be excluded from your route 
calculations.  For example, you may prefer to not travel on any 
toll roads. 
 

1. From the Destination Menu, press the Avoid Roads 
button to display a list of road categories.   

 
 Figure 40 - Avoid Roads (Restrictions) 

 
2. To place restrictions on a desired road category, 

highlight Restrictions and press  or  to 

suit your preference.  Press  to add a new 
category. 

 
3. Tap on Items to list all the roads in a highlighted 

category.  To specify restrictions for a particular road, 

highlight it and press  or .  To preview 
a highlighted road on the map screen, press the 

 button and select Show. 
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      Figure 41 - Avoid Roads (Items) 

 
4. Once you have specified your road restrictions, press 

 to return to the map screen. 
 

 
 

6.14 TMC 

 
 
Destinator PN supports TMC (Traffic Message Channel). 
 
TMC messages are national and regional public radio FM 
transmissions that are used to inform drivers of traffic, 
weather, and other driving conditions. TMC information is 
received by your PDA’s TMC-enabled GPS receiver and 
monitored by Destinator PN software. Destinator PN can 
automatically reroute your travel to avoid areas that TMC 
indicates might be troublesome to drivers. For instance, if 
there is a traffic jam, storm, or accident in your vicinity, 
Destinator PN can recalculate your route to avoid the 
problem. Note that TMC is currently not broadcasted in 
North America. 
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Follow the procedure below to configure TMC settings. Be 

sure you have first enabled TMC by  pressing the  

button, clicking on ,  and placing a check mark 
(√) in the box beside TMC GPS. 

1. From Destination menu, select  to display the 
TMC Inbox.  

 
2. Select Settings to display the TMC Settings dialog. 

Configure the settings on the dialog. 
 

 
TMC Events: Check the boxes corresponding to 
events that you want the Destinator PN software to 
monitor when it needs to recalculate your route. If you 
clear all events, Destinator PN will not report any 
TMC occurrences. 
TMC Effective Radius: Select the maximum effective 
distance that will be used in reporting TMC events.  
Destinator PN will process only those TMC events 
that occur within this radius of your constantly-
changing position on the road.  
TMC Avoidance: Check this box to cause Destinator 
PN to automatically recalculate your route to avoid 
TMC events that it is monitoring. If you do not select 
this option, you will have to manually select which 
TMC event is to be avoided and which is to be 
ignored, as the next section describes. You will still be 
alerted to TMC events whether you check this box or 
not. 

 
3. Close the TMC Settings dialog and then close the 

TMC Inbox. 
 
 
To View TMC Events   

 
1. From the Destination menu, select TMC to display the 

TMC Inbox. 
 
2. To see a TMC event on a map, highlight the event 

and select Show. 
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          Figure 42 - TMC Inbox  
 
3. To search for TMC events that are being broadcasted 

by other FM channels, select the arrows in the upper 
right and left corners of the screen. The outside left 
and right arrows scan FM stations continuously for 
TMC information. The inside arrows let you adjust the 
FM frequency station by station. The frequency and 
call name of the station currently received is displayed 
in the upper portion of the screen between the arrows. 

To Enable a TMC Event  
(Manual avoidance only) 

   
If you have chosen automatic avoidance, Destinator PN will 
recalculate your route automatically to avoid TMC events 
that affect your route.  
 
However, if you have not chosen automatic avoidance, you 
must manually select the TMC events that you want 
Destinator PN to avoid. 
 
To select a TMC event to avoid: 
 
1. From the Destination menu, select TMC to display the 

TMC Inbox. 
 
2. Highlight the TMC event you want Destinator PN to 

avoid in your route calculation and select the Avoid 
button. The Avoid button is available only if you have 
not chosen automatic avoidance. In addition, once 
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you avoid a TMC event in manual mode, the Avoid 
button will not be available for that TMC event again. 

 
TMC Banner 
 
Whenever Destinator PN receives a TMC event that occurs 
within the effective radius, a scrolling banner is displayed on 
the bottom of the map screen.  The banner briefly describes 
the TMC occurrence. 

 

 
 

Figure 43 - TMC Message Displayed on Map 
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7 7 
Options 

7.1 Introduction 
 
There are various route and map options available from the 
Options Menu.     
  
This chapter contains the following topics: 
 
• Showing your Route 
• Displaying Directions 
• Canceling your Route 
• Recording and Playing Back a Route 
• Switching Maps 
• Selecting Travel Mode 
• Getting Help 
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7.2 The Options Menu 

 
The Options Menu provides choices for displaying your route, 
displaying your driving directions, canceling a route, playing 
and recording a route, switching maps, selecting your mode of 
travel, and getting help with basic navigation. 
 

7.3 Show Route 

 
This option displays your route on the map screen in its 
entirety, plus details such as the address of and distance to 
your destination, the ETA (Estimated Time of Arrival), and the 
ETR (Estimated Time Remaining). 
 

7.4 Driving Directions 

 
This function displays a visual list of your route, distances to 
each maneuver, and street names.  By using the scroll bar on 
the right hand side, you can scroll through the entire route.  
Tapping on the maneuver twice displays that part of the route. 
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Voice and visual prompts (displayed at the top of the screen) 
are provided at varying intervals to indicate your next turn or 
change of direction. 
 

 
   Figure 44 - Driving Directions 
 

The Driving Directions screen also gives you several route 
options: 

Show Route 

  Displays your route on the map screen in its 
entirety, plus details such as the address of your destination, 
the ETA, and the ETR. 

Cancel Route 

  Cancels and clears the route from the map 
screen. 

Show Turn  

 Displays the highlighted portion of the list on the 
map screen, including the street name, distance to it, and an 
arrow diagram to indicate the turn.  You can also use the 
Prev and Next arrows to scroll to the previous or next turn. 
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Avoid Turn  

 Will recalculate your route to exclude this 
particular turn or maneuver. 
 

7.5 Turn By Turn 

 
This view indicates the distance to your next turn, and the 
name of the next street immediately after completing the 
previous turn.   
Voice and visual prompts are displayed at varying intervals to 
indicate your next turn or change of direction. 
 

 
 Figure 45 - Turn by Turn Dialog 
 
 
 
 
 
 
 
 



Destinator PN User Guide 

Page 81 of 118 

 

7.6 Cancel Route 

 
Cancels and clears the route from the map screen. 

 

7.7 Play 

 
This feature allows you to record your route as you’re traveling, 
and then to play it back on the map screen at a later time.  
From the Play/Record screen, you can record a route, play 
back a route, change the speed of the playback, and delete 

recordings.  Pressing  returns you to the map screen. 
 

7.8 Switch Maps 

 
This feature lets you switch between your maps.  The Switch 
Maps screen also displays details and version numbers of your 
maps, and allows you to delete maps. 
 

7.9 Travel Mode 

 
You can further define your route according to whether you are 
traveling by car or on foot.  This button lets you switch to 
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Pedestrian Mode or Vehicle Mode.  In Pedestrian Mode, the 
navigation radius is restricted to 10 kilometres (6 miles). 

 

7.10 Help 

 
This button launches an abbreviated help file with basic 
navigational definitions and instructions. 
 
 
 

7.11 About 

 
Displays software version and details about your Destinator PN 
application. 
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8 8 
Settings 

8.1 Introduction 
 
You can easily change the default settings of maps, views 
and route parameters to suit your personal preferences.     
  
This chapter contains the following topics: 
 
• GPS Status 
• Home Button Settings 
• General Settings 
• Map Settings 
• Route Settings 
• Alert Settings 
• Visual Notifications 
• Look & Feel 
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8.2 The Settings Menu 

 
The Settings Menu allows you to change the settings which 
determine how your route is calculated or displayed. 
 
 

8.3 GPS Status And Settings 

 
 
Destinator PN uses GPS signals to pinpoint your location. 
In Navigation mode, the software automatically acquires 
GPS signals and constantly updates your vehicle's location 
and position.  The GPS may take a few minutes to find its 
current location initially.  For best results, ensure that the 
GPS has a clear view of the sky. 
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       Figure 46 - GPS Status Screen 
 
 

To view your GPS configuration, click on the  
button.  You can access this button via the Settings Menu > 

GPS Status, or by clicking on the  button on the map 
screen. 
 

 
    

Figure 47 - GPS Settings Dialog 
 
GPS Settings Configuration menu: 
1. COM Port - Defines the Communications Port. 
2. Baud Rate - Transmission rate of data. 
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3. Protocol - Default is NMEA. 
Automatic reconnect – Select this option to ensure 

automatic reconnection whenever the GPS signal is lost. 
 
TMC GPS (Real Time Traffic) – Select this option to enable 

the TMC function.  See Section 6.14 TMC for a detailed 
description of this feature. 

 
Find GPS – Searches for and locates the GPS signal.  
Set GPS -  Sets the GPS Configuration. 
 

Press the  button to save your selections and return to 
the GPS Satellite graphic screen. 

 
 

8.4 Home Button Settings 
 

 
 
The Home Button Settings button lets you define an address 
or POI as your home destination.  Whenever you want to 
navigate to your home destination (for example, the nearest 

gas station), press the  button. 
 

In the Home Button Settings screen, select either POI Mode 
or Address Mode to set your desired destination.   
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Figure 48 - Home Button Settings Screen 
 

Press the  button to save and return to the map screen. 
 

Now, when you press the  button, Destinator PN will 
automatically calculate a route to this destination. 
 
 
 
 
 

8.5 General Settings 
 

 
 
The General Settings screen allows you to choose the unit 
of measurement for your route. 
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Figure 49 - General Settings Dialog 
 
 
All distances are displayed in imperial or metric units. 
 
1. Imperial (Miles and yards)  
2. Metric (Kilometers and meters)  
 
 

Press the  button to save your selection and return to the 
map screen. 
 
 
 
 

8.6 Map Settings 

 
The Map Settings screen lets you customize your map 
display. 
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Figure 50 - Map Settings Dialog 

Map Orientation 
 
Forward is up – orients the map so that your forward 

direction is always at the top. 
North is up – orients the map so that north is always at the 

top. 

Zoom Mechanism 
 
Automatic Zoom – ensures that the zoom will return to its 
previous level after several seconds of inactivity. 

Map Font 
 
Use large labels – increases the size of street names to 
make the map easier to read. 
 

Press the  button to save your selections and return to 
the map screen. 
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8.7 Route Settings 

 
 
The Route Settings screen lets you choose the parameters 
for route calculation. 
 

 
 
Figure 51 - Route Settings Screen 

Routing Mode 
 

Navigation Mode – Provides voice instructions as you drive.   
This mode is the one you will use most frequently.  Destinator 
PN uses the satellite-based global positioning system (GPS) to 
constantly detect your current position.  As you drive, your 
location is compared to the destination you have chosen and 
you will be constantly provided with accurate driving directions.  
Even if you accidentally drive off course, Destinator PN will 
direct you back on track. 
 
Planner Mode – Displays a route on the map.   
You set an origin and a destination, and Destinator PN displays 
a map that shows you the route.  In this mode of operation, the 
satellite-based global positioning system (GPS) is not used.  
Your current position is not detected and Destinator PN does 
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not keep track of your driving progress.  Use Planner Mode for 
trip planning. 

      

Route generation 
 
Quickest route – Destinator PN  calculates the route by 

picking the shortest distance and highest speed limits. 
Shortest route – Destinator PN calculates the route by 

picking the shortest distance. 
 

   Note: Route generation excludes any detours, stops or delays along the 
route. 

 

U Turn Usage 
 
U Turn enabled - If you select this option, the route will be 

calculated by including any U Turns that are needed. If 
you clear this option, the route will be calculated without 
any U Turns.  (This feature is included because some 
drivers prefer not to make U Turns.) 

 

Press the  button to save your selections and return to the 
map screen. 
 

 

8.8 Alert Settings 
 

 
 
This screen displays warnings and alerts which, when 
selected, will provide voice prompts. 
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 Figure 52 - Alert Settings Dialog 
 
Voice Prompts 
 
1. Speed Limit - Gives you a voice prompt when your car 

exceeds the speed limit on this section of the road. 
2. Route Recalculation - If you deviate from the original 

route, Destinator PN automatically recalculates a new 
route and updates ETA and distances. 

3.   Low Signal - Warns that you are in an area of low GPS 
signal. 

4. GPS Not Found - Alerts you if the GPS signal is lost, or 
if power is removed from the GPS receiver. 

5. Drive Carefully - Friendly reminder at the start of each 
journey. 

 
TTS Activation – Check this box to enable the TTS function. 
 
The TTS (Text To Speech) feature inserts street names into 
the voice prompts at 200 meters prior to a maneuver, as well 
as when you reach the maneuver.   
In order to become active, TTS must first be installed from 
the Console. 
  
 

Press the  button to save your selections and return to 
the map screen. 
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8.9 Visual Notifications 
 

 
 
The Visual Notifications screen lets you choose how 
Destinator PN notifies you of your upcoming turns. 
 

 
 
Figure 53 - Visual Notifications Screen 
 
1. Text – Visual notification is displayed in written form. 

 
2. Symbols – Visual notification is displayed in pictorial 

form (as an arrow diagram). 
 

3.   None - No visual prompts are displayed. 
 
 

Press the  button to save your selections and return to 
the map screen. 
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8.10 Look & Feel 

 
 
The Look & Feel screen allows you to customize how 
Destinator PN looks and sounds. 
 

 
 

Figure 54 - Look & Feel Screen 
 
 
Voice Prompts – Default or change to different voice.  See 
Destinator Community at  www.destinator1.com.  Click on 
Community, login and select Skin Designer. 
 
 
Skin – Default skin or different skins, if available.  See 
Destinator Community at  www.destinator1.com.  Click on 
Community, login and select Skin Designer. 
 
 

Press the  button to save your selections and return to 
the map screen. 
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9 9 
Changing Map Views 

 

9.1 Introduction 
You can change your view of the map, and the way in which 
the map is displayed on the screen. 
 
This chapter contains a description of the following topics: 
 
• How to Zoom and Scroll 
• Types of Views 
• Day or Night Mode 
 

 



Destinator PN User Guide 

Page 96 of 118 

9.2 How to Zoom and Scroll  
 

  
 
 Figure 55 - Zooming Scroll Bar Window 
 
 
The Zoom scroll bar can be used to Zoom In (+ Magnify) or 
to Zoom Out (- Expand) on the displayed map. 
 
With Automatic Zoom selected (Settings Menu > Map 
Settings button) you can use the zoom buttons to override 
the auto zoom, but the zoom will return to its previous level 
after several seconds of inactivity. 
 
When Automatic Zoom is not selected, you can zoom in or 
zoom out manually and it will remain at that level. 
 
 
You can scroll the map by holding your stylus on the screen, 
and dragging the image in any direction. 
 

 

Zoom Scroll Bar
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9.3 Types of View 

The  button on the map screen toggles between 4 types 
of views: 2D, 2D Night, 3D and 3D Night.  The icon indicates 
the next view to be displayed. 
 

2D View   
  
The 2D view is the straight-forward two-dimensional view.  
This is the default map view.  In this view, the map is 
dynamically updated, and allows for manual panning and 
zooming. 
 

2D Night View   
 
This is a high contrast, two-dimensional view, optimized for 
night driving or adverse weather conditions.  The map is 
dynamically updated, and allows for manual panning and 
zooming. 
 

 
 
          Figure 56 - 2D Night View 
 
The route, start point and destination (outlined in blue) are 
clearly seen and visible under a variety of weather and 
driving conditions. 
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3D View   
  
The 3D view is a simplified three-dimensional view showing 
the map in a basic 3D relief.  It shows the basic relief 
(outline) and details of the surrounding roads and general 
area. 
 

  
 

   Figure 57 - 3D View  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Origin 
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3D Night View   
 
The 3D night view is a simplified three-dimensional view with 
high-contrast colorization optimized for night driving or 
adverse weather conditions. 
 

  
 

           Figure 58 - 3D Night View 

Origin 
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10            10 
Auto & Favorites Alerts 

10.1 Introduction 
An Automatic Alert refers to an item that you configure so 
that Destinator will alert you when you are within a certain 
distance of the item’s location. You can configure two 
distances for each Automatic Alert. Destinator will first alert 
you when you are within the first distance and then alert you 
when you are within the second. Automatic Alerts must be 
stored in either one of three predefined categories - Auto 
Alerts 1, Auto Alerts 2, and Favorites Alerts.  

 
 

10.2 Configuring Auto Alerts Category 
 

Note that this configuration is applied to all items in the 
category. 
 
1. From the Destination dialog, select Favorites. 
 
2. Highlight the Auto Alerts folder you want to configure 

and select Edit… from the Tools menu in the lower-
right corner. 

 
3. To enable both alerts, check both boxes. Or, you can 

disable one of the alerts by clearing the box next to it. 
If you configure two alerts, the first must have a 
greater distance than the second. 

 
4. From the pull-down menus, select a distance for each 

enabled alert. Destinator will alert you when the 
distance between your current traveling position and 
the location of the alert equals the distance you enter 
here. 

 
5. Close the Edit menu. 
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6. To display the map position of items in the Auto Alerts 
category, check the box to the left of the category 
name, just as you would to display map positions of 
items in any other category. 

 
7. Select Save to complete the configuration. 

 
 

10.3 Configuring Auto 
Alerts Items 

You can change the name, comment, and category of any 
item in Auto Alerts 1 or Auto Alerts 2. Note that if you change 
the category of an item to something other than Auto Alerts 1 
or Auto Alerts 2, it will no longer function as an auto alert. 
Only those items in categories Auto Alert 1 and Auto Alert 2 
will function as automatic alerts. 

 
1. From the Destination dialog, select Favorites to 

display all the categories.  
 
2. Highlight a category and then select Items from the 

upper menu bar. All items in the category are 
displayed. 

 
3. Highlight the alert you want to edit and select Edit 

from the tools menu in the lower right corner. 
 

4. You can change the name, comment, and category of 
an item. You cannot change any other information. 
Note that if you change the category, the item will be 
moved out of the current category. Only those items 
found in either Auto Alerts 1 or Auto Alerts 2 will 
function as auto alerts. 

 
5. Close the edit window. 

 

10.4 Favorites Alerts 
From the Favorites folder, you can add a new Category 
called Favorites Alerts.  These alerts function the same 
way as Auto Alerts, but can be used specifically for items 
from your list of Favorites, such as your favorite restaurants 
and places of interest.
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11             11 
Favorites Importing 

 

11.1 Introduction 
Destinator PN Professional Edition also lets you download a 
list of locations from your PC to any category within 
Favorites on your PDA. Creating information about locations 
in this way is much faster than entering the information via 
the PDA keyboard. A practical application of this time-saving 
feature could include a commercial vendor who would create 
a list of all retail outlet locations in a specific area. Destinator 
users could then download the list quickly to their PDAs. 
 
You can download a list of locations from your PC to your 
PDA to any category within Favorites, including Auto Alerts. 
The list must be contained in *.csv files.  As part of the 
download procedure, you convert the *.csv files to *.dat 
format for storage on your PDA by using a Destinator 
conversion utility.  
 

11.2 Downloading Favorites  
 

1. Be sure your PDA is connected to your PC. 
 
2. Launch the Destinator Console from the start menu 

of your PC. 

Start > Programs > DestinatorApps > Destinator Console 
 
3. On the Destinator Console, click on a Standard Map.  

This will enable the Installing Map and Favorites 
Importer features. 

4. Click the Favorites Importer button. The converter 
dialog is displayed. 
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5. Select the file (*.csv format) containing the automatic 
alert.   

 
About the *.csv file: Appendix A describes csv format. 
Basically, the *csv file contains addresses and 
longitude and latitude values for locations. The file 
must contain exact street address, ZIP/Postal Code, 
and city data. However, the longitude and latitude 
values can be omitted because the Destinator 
software will query the map you selected in Step 3 
above for any missing longitude and latitude. If the 
*.csv file does not contain longitudes and latitudes, 
the separating commas must still be included, as 
Appendix A shows.  

 
 
6. Convert the .csv file to .dat format by highlighting the 

file, entering a Category Name, and selecting the 
Convert button.  The Report area of the screen will 
display a message stating that the content of the file 
has been converted and that the file is ready for 
download. 

 
 

7. Download the file to your PDA by selecting the 
Download button. 
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Glossary 
 

This glossary describes terms and abbreviations used with Destinator PN. 
 

 
Abbreviation Name Description 
COM PORT Communications 

Port 
In Computer systems, the name of a 
serial communications port - Eg: COM1, 
COM2, COM3, and COM4. 

EULA End-User License 
Agreement 

Is a legal contract between a software 
application author or publisher and the 
user of that application. The EULA, often 
referred to as the "software license," is 
similar to a rental agreement; the user 
agrees to pay for the privilege of using 
the software, and promises the software 
author or publisher to comply with all 
restrictions stated in the EULA. 

ETA Estimated Time of 
Arrival 

The estimate time to complete the 
journey, if we where to leave now.  
Excluding any detours, stops or delays 
along the route. 

ETR Estimated Time 
Remaining 

Estimated Time remaining to complete 
route.  Does not allow for any delays. 

FAQ Frequently Asked 
Questions 

List of Frequently Asked Questions with 
Answers. 

GPS Global Positioning 
System 

The GPS (Global Positioning System) is 
a "constellation" of 24 well-spaced 
satellites that orbit the Earth and make it 
possible for Vehicles/ people/ assets 
enabled with GPS receivers to pinpoint 
their location. 

Lat Latitude An imaginary parallel circular line (East / 
West) around the earth, the same 
distance, north or south from the equator 
– expressed in degrees. 

Long Longitude An imaginary circular line on the surface 
of the earth passing through the North 
and South poles at right angles to the 
equator - expressed in degrees. 

Orbit Orbital path of a 
Satellite 

Path or trajectory of a body through 
space.  A GPS satellite traces out an 
orbit about the earth. 

POI Point Of Interest A place or item of interest along the 
selected route. 
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Abbreviation Name Description 
Sat 
 

Satellite  
See also GPS 

A man-made object, or device that orbits 
the earth. Eg: a GPS Satellite which 
orbits the earth in a fix pattern, height 
and speed 

SD Secure Digital 
memory card 

A Secure Digital (SD) card is a tiny flash 
memory card used to make data storage 
portable among various devices. 

TTD Total Time 
Duration 

The projected total time the trip is 
calculated to take - does not allow for 
any detours or other delays. 
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Appendix A - Favorites Importing File Structure 

 
The Favorites Importing file structure must be in CSV (Comma-Separated Values)* 
Format  
 
The file contains the following fields: 
1. Name of the point. 
2. Comment. 
3. Longitude. 
4. Latitude. 
5. ZIP/Postal Code. 
6. City. 
7. Street. 
8. House number. 
 
The Longitude and Latitude are numerical values; all the others are strings. 
If a string value contains a comma, the field must have quotation marks. 
 
Examples: 
Text 
Favorite place 1,Destinator Favorites Convertor Comment 1,39.21370,38.78903,8033,Munich, 
Ariboweg ,1 
Favorite place 2,Destinator Favorites Convertor,comment 2,24.85091,34.33012,1070,Brussels, 
Moutstraat “Weg”,183 

Table 
1 Name 2 Comment 3 Long 4 Lat 5 ZIP/ 

Postal 
Code 

6 City 7 Street 8 Number 

Favorite 
place 1 

Destinator 
Favorites 
Convertor 
Comment 1 

39.21370 38.78903 8033 Munich Ariboweg 173 

Favorite 
place 2 

Destinator 
Favorites 
Convertor 
Comment 2 

24.85091 34.33012 1070 Brussels Moutstraat 
“Weg” 

183 

Favorite 
place 3 

Destinator 
Favorites 
Convertor 
Comment 3 

44.80999 38.16141 1096  Amsterdam Joop 
Geesinkweg 

9003 

Favorite 
place 4 

Destinator 
Favorites 
Convertor 
Comment 4 

24.79360 37.08604 75010 Paris Rue Danton 3013 

Favorite 
place 5 

Destinator 
Favorites 
Convertor 
Comment 5 

44.97889 23.82718 8044 Zurich Frits Weg 123 

 
* CSV (comma-separated values) file contains the values in a table as a series of ASCII text 
lines, organized so that each column value is separated by a comma from the next column's 
value and each row starts a new line. 
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Appendix B - Manual Activation of Destinator PN 

• Obtain the Device ID of your Pocket PC 
• Obtain your Activation Key online at 

http://activate.destinator1.com/  
• Enter your License and Activation Keys into your 

Pocket PC 

On the Pocket PC  
 

  Note: Some versions of Destinator will operate unregistered (those with 
the Destinator Lite option) for a short time (evaluation only) with limited 
functionality.  

1. From the Start menu launch Destinator . 
 

2. Destinator pops up a screen indicating that you are 
running an unregistered version.  Click YES and you 
will be taken to the Destinator Activation window. 

 

 
 

Figure 59 - Destinator Activation Dialog 
 
3. Enter your License Key (found on the first page of 

the Destinator Quick Start Guide) and click Next.   
 
 
4. Enter your Activation Key (obtained online) and click 

Next.   
 

Device ID 

License Key 
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5. The Activation Successful screen indicates that 
your Destinator has been activated.  Click on Finish, 
then Done to close the Activation window. 

 
 

  Note: Destinator is copy protected and will only run on the Pocket PC 
device (PDA) you originally registered.   

 

If you retire an old device, you can move your Destinator license to a new 
device.  Go to http://www.destinator1.com  click  Community, login, 
Activation, choose Move License to a different device and follow the 
on screen instructions to complete the registration process. 
 

Online Activation 
 
By activating your product, you will have access to updates, 
FAQs, new skins, utilities and other Destinator features and 
add-ons.   

 
1. Point your web browser to 

http://activate.destinator1.com/. 
 
2. If you already have a Destinator Community 

username and password, login and click on 
Activations >Activate Another Product.   

 
If you are a new user click on the link 

 
 
3. Follow the onscreen instructions to complete the 

activation process.   If you need help, click the Need 
help with installation? Click here! link.  

 
 

 
 
Figure 60 - Entering a License Key or Voucher ID Number Page 
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4. You will be emailed a copy of your chosen Login 
Name and Password.  When you complete the 
registration screens, you are prompted to enter your 
License Key or Voucher ID number then press Next.   

 
 
5. Enter your Device ID then press Finish.  (Found on 

your Pocket PC in the Destinator Activation window). 
  

 
 

      Figure 61 - Activation Key Details Page 
 
6. When you are done activating, the Community 

Activation page will display your Activation and 
License Keys.  Enter these into your Pocket PC to 
complete the activation process.   

  Note: If you have purchased extra maps or other Destinator add-ons, you 
may need to provide Destinator with additional activation key(s).   

Activation Key 
License Key
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Appendix C – Sending a Location as an SMS Message 
Destinator PN allows you to send a location to someone via 
an SMS (Short Message Service) message.  In order to 
receive the SMS message, the recipient must have a 
PPCPE device that is running Destinator PN, or a Destinator 
SP (SmartPhone).  The SMS message will include a location 
to which they can navigate. 
 
To send a location with an SMS message, select Send 
Location from the Tools menu found in the Address, POI, 
Favorites, History, Contacts, and SMS Inbox screens to 
send the destination currently highlighted.  
 
 
1. Click on Send Location in the Tools menu.  Your list 

of Contacts is displayed.  
 

 
  
2. Highlight the Contact you want to send your SMS 

message to, and press Send.  The SMS Contents 
screen is displayed.  
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3. The Mobile number of your contact is automatically 

entered into the first box.  You can add a message of 
up to 20 characters in the second box.  The third box 
displays the location of the destination you have 
highlighted.  For example, if you have selected a 
location from the POI screen, the location of the POI 
will be included in this box.  

 
4. Press Send to send the SMS message.  A 

confirmation message will confirm that the message 
was sent. 

 
5. If you want to send an SMS message to someone 

who is not listed in your Contacts folder, select Your 
Number when the Contacts list is displayed. 

 

 
 

6. Press Send, and the SMS Contents screen is 
displayed, but the Mobile # field is left empty.  You 
can enter any valid mobile number into this field. 
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7. Press Send to send the SMS message.  A 

confirmation message will tell you that the message 
has been sent. 
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